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Rev | Description/changes Date
(dd-mm-yyyy)
A First version 29-06-2015
B Some macros are updated to B-version: 24-04-2017
Panel layout/graphical macros are simplified. For DU-300 different folios are
added.
Logo exchanged with new.
Added two new cards, IOM3.4 and GAM3.2 (future releases)
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Introduction

The new Multiline 300 controller line by has now been released from DEIF. This document introduces the
related Eplan Macros.
As of now the macros consists of:

1. Diagram macros. To be used on Eplan standard multiline diagram pages. As DEIF controllers can be percived as a
PLC, the makros are built as PLC-boxes with PLC terminators. The macros are divided into single units, e.g.
measurement units or digital inputs for most flexible layout of diagrams

2. Overview macros. To be added at (PLC) overview pages. These will contain the article no and the function definition
for each unit. The function definition links to the diagrams macro. The overview pages provide cross-references to the
pages where the diagram macros are used.

3. Graphical macros. To be used when presenting a graphical view of the controller. The graphical macro is also used for
2D panel layout

At a later point 3D ProPanel macros will be added.

Window captures in this guide is taken from the Danish version of Eplan on an English Windows
installation. Please be free to extrapolate to your own languages

Importing

The marcros are downloaded from DEIF’s homepage as edz-files which is an Eplan article database
exchange format. One edz-file contains the article database entry as well as all macros defined in the
article data. The macros will be placed in the right folder structure under the macro folder as specified in
the setup -> User -> Administration -> Folders setup in Eplan. Please be aware if the folders are set to
local computer or a network drive.

After downloading the procedure for importing is as follows:

1. Open the article administration
2. Press the extra button and choose import

Gene... |priser /..| Frie eq.. | Egensk. | Monte.. | Tilbehar | Teknis..| Doku..| Fremst..| Data ti..| Funkti..| Enkelt. | PLC-..| Sikker..|
Eeltbaseret filter.

Elektroteknik vl |- Aktiv Produktovergruppe: Elektroteknik v

Fuldtekstilter: Produktgruppe: PLC v

K
Produktundergruppe: Generelle v

I DEILML-2 M132 (Option 7 ¢ A

I DELML-2_ M1356 (Option 7 ¢ Any e
Il DEIML-2_ M13.8 (Option 7 ¢ e — DEIF.2912210030-01
I DELML-2_ M14.2 (Option 4 r =

Il DELML-2_M14.4 (Option 4 r []udgaet artikel
Il DELML-2 M14.6 (Option 4 r
]1|DE\ML—2 M14.8 (Option 4 relay out u||| ERP-nummer:
I DEIML-2_ M156 (Option 4 2
I DEIML-2 M15.8 (Option 4 2 e
I DEILML-2_ M1656 (Option 4 r
I DEILML-2 M16.8 (Option 4 r

2912210030-01

Betegnelse 1 Generator Protection and Paralleling Unit

I DEIML-2 M4 (Option engin Betegnelse 2 24VDC, 1-5A, 690 VAC
I DEIML-2.N (Option etherné

I DELML-2-ASC-basic (Advan Betegnelse 3

o

1l DEIF.2912210520-01 (Gemp Fabrikant: DEIF A/S

1 DEIF.2912210520-01_1 (Gen

Il Gempac KTAS0 (Generator « Leyerandor:

1 NO_USE_DEIF.2912210030-(
1 SIE6ES7321-1BHO2-0AAD (!
@ @ Relaer, kontaktorer
7 & Spaendingskilde og generator
o @ St
+ @ Sterkstramskoblingsudstyr
= B Tilbehar
s O Transformatorer
@ 7 Udefineret
2 ® Varme

Bestillingsnummer.

Begkaivelse:

Vrmbinnnne

< I >

| ree[Liste] Kombination Eksta - Luk
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Importer...
Eksporter...

Pladsbehov

Priser ...

Valutaer...

Sammenlaeg funktionsskabeloner
Tildel funktionsskabeloner...

My database... |
Opdater sggeindeks

Indstillinger...

3. Set the file type to ‘Eplan data portal exchange format’ and choose ‘update existing data and add new’

Filtype: |EPLAN Data Portal-udvekslingsformat

Filnavn: | Q\Eplan\Personal\SEH\Parts export\PSM31.edz

Felttilknytning: [Standardindstilling EPLAN v D

() Tilfaj kun nye dataposter
() Opdater kun eksisterende dataposter

(®) Opdater eksisterende dataposter, og tilfgj nye

| ‘ Annuller
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4. Choose the file you want to import and Open

5.

Look in:

<»

Recent places

|

Desktop

u1|
Libraries

A

This PC

@.

Network

| Paris export v @ 7@y
] Name - Date modified Type Size
ACM31.edz 11-06-2015 06:42 EDZ File
BP31.edz 11-06-2015 06:41 EDZ File
DU300.edz 11-06-2015 06:41 EDZ File
EIM31.edz 11-06-2015 06:40 EDZ File
GAM31.edz 11-06-2015 06:39 EDZ File
10M31.edz 11-06-2015 06:38 EDZ File
ML-300.edz 11-06-2015 06:45 EDZ File
PCM31.edz 11-06-2015 06:37 EDZ File
| PSM31.edz 11-06-2015 06:36 EDZ File
R71.edz 11-06-2015 06:35 EDZ File
< >
File name P5M31 v ‘ Open
Files of type EPLAN Data Portal-udvekslingsformat (*.edz) v Cancel
Sti: Q\Eplan\Personal\SEH\Parts export

6. Press ok. And the article is imported.

Artikelimport: XML

Artikelimport: XML

Annuller

Now the part is imported together with the macros.

*Tip: when selecting several edz-files, all the articles are imported.

4040000003E

Printed date: 170428

Page 5 of 27



DEIF ML-300 Eplan macro user guide Ref: SEH / Rev. B

-power in control _

The part can now be found in the article database.

Gene... |Priser /..| Frie eg..| Egensk..| Monte.. | Tilbehgr | Teknis..] Doku..| Fremst.. | Data ti..| Funkti..| Enkelt..] PLC-..| Sikker..|
Eeltbaseret filter:

Eleldroteknik vl o] Da P |Elektroteknik vl

Fuldtekstfilter: Produktgruppe: ‘ PLC v ‘

| | [a]=] Produktundergruppe: [Generelle v

I DELML-2_M13.2 (Option 7 ¢ ~
I} DELML-2_M13.6 (Option 7 ¢
- [ DEIML-2_M13. (Option 7 ¢
) DELML-2_M14.2 (Option 4
) DELML-2_M144 (Option 4 [] Udgdet artikel
1) DELML-2_M146 (Option 4
1) DELML-2_M148 (Option 4 ERP-nummer ‘
I} DELML-2_M156 (Option 4
10 DELML-2_M15.8 (Option 4 z Typenummer:
I} DELML-2_M166 (Option 4
- [ DEIML-2_M16.8 (Option 4
I} DELML-2_M4 (Option engin ErmrnE ‘ 12/ 24 VDC, max 35 W
[ DELML-2_N (Option etherne
[ DELML-2-ASC-basic (Advan Betegnelse 3: ‘
1) DELML-300_PSM3.1 (Power
1) DEIF.2912210030-01 (Gener Fabrikant: ‘ DEIFA/S |E |
1) DEIF.2912210520-01 (Gemp
[ DEIF.2912210520-01_1 (Gen Leyerandr. ‘ |E |
~[l Gempac KTAS0 (Generator «
I NO_USE_DEIF.2012210030-( =l puspu g ‘
1) SIESES7321-1BHO2-0AAD (¢
® Relzer, kontaktorer
4B Spandingskilde og generator
W stik
B Steerkstrmskoblingsudstyr
5 Tilbehar
I Transformatorer
2 Udefineret

M \rarma
< >

Tree [Liste | Kombination | Ekstra ~

Anvendelsesomrade / underomrade: ‘ Elektroteknik ‘E

Artikelnummer. ‘ DEIML-300_PSM3.1 ‘

‘PSM3.1

Betegnelse 1: ‘ Power supply module

Beskrivelse:

| Luk ‘ Anvend

In the technical data tab the link to the macro that contains the graphical macro as well as the overview
macro can be found:

Gene.. | Priser /..] Frie eg..| Egensk..] Monte..] Tilbeher [Teknis... | Doku..| Fremst..| Data ti..] Funkti..| Enkelt..] PLC-..] Sikker...]

Feltbaseret filter:
Elektroteknik v o] Daaw Tekniske storrelser PsM3

Fuldtekstfilter:

\ | [m] =]

[ DELML-2_M13.2 (Option 7 ¢ ~
[ DELML-2_M13.6 (Option 7 ¢ Eunktionsgruppe:
-l DELML-2_M13.8 (Option 7 ¢

Gruppenummer.

Deltype:

[ DEIF.2912210030-01 (Gener
[ DEIF.2912210520-01 (Gemp
<[l DEIF.2912210520-01_1 (Gen
M Gempac KTA50 (Generator i
[ NO_USE_DEIF.2912210030-(
[ SIESEST321-1BHO2-0AA0 (¢
@ Relacer, kontaktorer

A® Spandingskilde og generator
@ stik

B steerkstramskoblingsudstyr

5 Tilbehgr

‘O Transformatorer

-2 Udefineret

W \arma
< >

Tre [Liste] Kombination Ekstra -

Tilslutningsmenster:

1 DELML-2_M14.2 (Option 4 Sliddel: ‘ “" E
[ DELML-2_M14.4 (Option 4 ¢
Reservedel v
10 DELML-2_M14:6 (Option 41 Heserveds ‘ | [x]
% EE: mt'i—mgz Egptm" Z r Smering / vedligeholdelse \ vl E
| 2} ption 4 3
[ DELML-2_M15.8 (Option 4 a Levetid ‘ “" E
[l DELML-2_M16.6 (Option 4
[ DELML-2_M16.8 (Option 4 Belastning \ v‘ E
[ DELML-2_M4 (Option engin
-l DELML-2_N (Option etherne Anskaffelse: ‘ *" E
DELML-2-ASC-basic (Ad
% SR TLe PSMa;!lE((POV‘VI::' Makro: | DEIRML-300\DEIF_ML-300_PSM31ema I=]

™

‘ Luk Anvend
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Which is now placed in the right folder:

Home Share View

- 4 |« Makroer » 150379553 » DEIF » ML-300 v ¢ Search ML-300

~ [ Name Date modified

@ OneDrive

‘D | DEIF_ML-300_PSM31.ema 10-06-2015 15:49
DEIF_ML-300_PSM31_ETHCAT_N1.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_ETHCAT_N2.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_PS_1_2.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_RO_3_4.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_RO_5_6.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_RO_7_8.ems 10-06-2015 09:26

& This PC
ly Desktop
| Documents
'3 Downloads
¥ Music
& Pictures
B Videos
£ OSDisk (C)
& cust-support (\deif.com\files) (M:)
< seh (\deifsrvdS\Home_dir2$) (P:)
= udv_dat (\\deif.com\files) (Q:)
— dok_dat (\deif.com\files) (R:)
— proj_dat (\\deif.com\files) (5:)
< adm_dat (\\deif.com\files) (U:)
< prod_dat (\deif.com\files) (V)

7 items State:@ Online

In the function definition tab each connection on the card is linking to a symbol-macro. This is the macro

used in the diagram.

Gene..| Priser /..| Frie eg...| Egensk..| Monte...| Tilbeher | Teknis..| Dok...| Fremst..] Data ti.. Funkti.. |Enkelt..| PLC-..] Sikker..|

Bnnn

Feltbaseret filter:

Elektroteknik v D [ Aktiv o dvalg (ft

):
Fuldtekstfilter: Rakke|  Funktionsdefinition |||| Symbolmakro Bus-system | Tilslutnings...| Tilslutnings
‘ ‘ E 1 PLC-boks [ Andre bus-..
2 |pic-tilslutning, PLC-KV (.. [|IDEIF\ML-300\DEIF ML-300 PSM31_PS 1 2.ems 1 B
[ DELML-2_EF6 (Option 1 PW A 3 |PLC-tilslutning, PLC-KV (-) | |DEIF\ML-300\DEIF_ML-300_PSM31_PS_1_2.ems 2 B
[ DELML-2_F1 (Option 2 analc 4 PLC-tilslutning, PLC-kort. H}DHF\MLGOU\DHLMLGOUJSM31,R0,3,4.ems = 3 C
Il DELML-2_H12.2 (Option 2 C 5 |PLC-tilslutning, DA IDEIF\ML-300\DEIF_ML-300_PSM31_RO_3_4.ems 4 NO
I DELML-2_H12.8 (Option 2 C 6 |PLC-tilslutning, PLC-kort.. ||IDEIF\ML-300\DEIF_ML-300_PSM31_RO_5_6.ems 5 c
ﬁ gimt?:g Egzg‘;g ;”[Z:z 7 PLC-tilslutning, DA IDEIF\ML-300\DEIF_ML-300_PSM31_RO_5_6.ems 6 NO
I DEIML 2 H5 (Option 2 CAM 8 |PLC-tilslutning, PLC-kort.. | |JDEIF\ML-300\DEIF_ML-300_PSM31_RO_7_8.ems 7 C
I DELML-2.H6 (Option 2 moc 9 |PLC-tilslutning, DA IDEIF\ML-300\DEIF_ML-300_PSM31_RO_7_8.ems 8 NO
1 DELML-2_H8.2 (Option 2 C# 10 |PLC-tilslutning, PLC-KV (.. ||JDEIF\ML-300\DEIF_ML-300_PSM31_PS_1_2.ems F/G Frame grou
[l DELML-2_H8:3 (Option 2 CA 11 |PLC-tilslutning til buska.. ||JDEIF\ML-300\DEIF_ML-300_PSM31_ETHCAT_N.. |Andre bus-.. N1 ETHCAT
Il DELML-2_H9 (Option modb 12 |PLC-tilslutning til buska.. ||| DEIF\ML-300\DEIF_ML-300_PSM31_ETHCAT_N.. |Andre bus-.. N2 ETHCAT

[ DELML-2_M12 (Option anal
1 DELML-2_M13.2 (Option 7 ¢
1 DELML-2_M13.6 (Option 7 ¢
M DELML-2_M13.8 (Option 7 ¢
- DELML-2_M14.2 (Option 4
[ DELML-2_M14.4 (Option 4 r
[ DELML-2_M14.6 (Option 4 r
1 DELML-2_M14.8 (Option 4 r
1 DELML-2_M15.6 (Option 4 2
- DELML-2_M15.8 (Option 4 2
[ DELML-2_M16.6 (Option 4 r
M DELML-2_M16.8 (Option 4 r
[ DELML-2_M4 (Option engin
- DELML-2_N (Option etherne
[ DELML-2-ASC-basic (Advan
[ DELML-300_PSM3.1 (Power

1 DEIF.2912210030-01 (Gener 8 4
M NFEIE 2012108201 /Gamn
>

<

Tree [Liste] Kombination | Ekstra -

‘ Luk ‘ Anvend

This symbol-macro belongs to terminal 3 on the PSM3.1-card and is the common on the status output
relay. Some macros represent more terminals and all the terminals will then be imported together in the

diagram.
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The symbol-macros are also placed in the right folder:

Home Share View

®© « 4 ) « Makioer » 150379553 » DEIF » ML-300 v ¢ | Search ML-300

» [ Name Date modified

@& OneDrive
DEIF_ML-300_PSM31.ema 10-06-2015 15:49

DEIF_ML-300_PSM31_ETHCAT_N1.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_ETHCAT_N2.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_PS_1_2.ems 10-06-2015 09:26
| DEIF_ML-300_PSM31_RO_3_4.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_RO_5_6.ems 10-06-2015 09:26
DEIF_ML-300_PSM31_RO_7_8.ems 10-06-2015 09:26

& This PC

Iy Desktop

I Documents
4 Downloads
¥ Music

& Pictures

B Videos

% 0OSDisk (C)

& cust-support (\\deif.com\files) (M:)
= seh (\deifsrvS\Home_dir2$) (P:)
< udv_dat (\\deif.com\files) {Q)

- dok_dat (\\deif.com\files) (R}

— proj_dat (\\deif.com\files) (5:)

= adm_dat (\\deif.com\files) (U:)

= prod_dat (\deif.com\files) (V2)

-~

7 items S‘[ate:@ Online
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Using DEIF Eplan macros

When using the eplan macros it's recommended to read the DEIF installation manual for the product, and
have it available when drawing. The installation manual can be downloaded at www.deif.com

The first step is to create an overview page.
For ML-300, overview pages should have the grid set to 5 mm.
On the overview page the various components of the controller are placed. Each controller consists of:

- Onerack

- A number of cards

- A number of blind plates to fill out empty slots, if any.
- Adisplay unit, if any

On the first overview page for the controller the rack is placed, that is the overview macro of the rack which
contains the article.

1. Choose Insert->Component and find the rack

Vis Prgjek‘tdata S@g Funktioner Hjalpepr:
€ = Symbol... INS

- 28 Vindues- / symbolmakro... M

» Komponent... ALT+INS

Tilsluttede funktioner

Grafik »
| Malsatning »
— | Specialtekst 4

(here the filter is used to find it)

Fuldtekstfilter:

R7.1 | %

Altiv

=50 Artikler
=57 Elektroteknik
=77 Enkeltdel
= PLC

4040000003E
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2. Because this is an overview page, the overview variant of the rack macro will be inserted. The macro can be freely
placed

S0 A
w71

X

g

DEIF uses ‘prefix-page-designation letter-continous’ designation of components as in this example. Any kind of
designation can be used, just the different parts (racks, cards and displays) has different designations. This rack is placed
on page 9, and it is the second controller in this project, thus the designation is -9K2.

4040000003E
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3. The first card, can now be placed which is a PSM3.1 (should be placed in the first slot) can now be placed. Again choose
Insert -> Component and find the PSM3.1 module. Place it again with X and Y coordinates. This will place the PSM just
below the rack. It may be neccesary to re-designate the card.

Here to -9K2.1 because it is the first card in the controller.

-9K2 B 5
Comsa|

-9K2,1
e

Frame graund FGO|
+ - Lo
- - 2o

C - 30m)
NO - 4|

C - 5ol
NGO - Somf

C 7o)
NO - B

ETHCAT W1ce))

. ETHCAT N2l e

Designer Rev.no Flename or
DElP‘ = I LN [Simulator panel, 2M, 26, 1 BTB

.......... I
T Rea.idité Ir W-‘.Tictn: - ‘

4. The second card can now be placed. It is in this instance an ACM3.1. Instead placing it with X and Y, I only fixed the Y
direction while pressing Y after getting the macro. It is only possible to place two cards on each page to make space for
cross-reference and function text to the right of the terminals.

L OK2
Reck 7.
-9K2.1 MG -OK2.2 [
| e ._.J L — . AOBL = L
Frame ground FIG ) VAl - 10
R N . L PP L v 20w -
- 20mf VI3 - Jom,
- WaN dpm| -
<ol oo Space for function text - - PR oW s -
L wo - aomll - . I B B L v 0wl -
V213 - Fom,
C - 5o VI - 8w
HO - 6o
L . L P PP CHLSL soe) -
C - 7om) » H152 4008
. no somlll - H . L P PP S
e H251 110w
(] M52 120w -
[ -
85 SU3SL 130w -
I Tl B
o
P
a 9 .
Cax - LNSL 150w -
- : © NS dEpe .
ETHCAT W10
ETHCAT W2t
Flename Simulator panel, 2M, 2G, 1 BIB [ _ Cismmer | Page description [ Doaimentna

4040000003E
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5.

Additional cards and blind plates are placed on the following pages to fill all slots.

-9K2.3 [y 0k 4 boer
oML EMHEJ
NO - 10w Frame ground FG o)
20m) + - lem
o - 2ow
) R C -3pm
B@D| e e R NO -6
NE CBOR| - e e e e o
.......... C -sem
NO 7o NO 6o
s
NE - 50 C 7o
NO - BE
NG 10C
11| C -sem
NC 120 NO 10cw
Df i3g= DI t1o%
Of 140w oI 120
o 150w DI 130
[ Rt DI 4o
DI 7G|« e e e e e o 150
DI B« o e e e e . o
DE 9G] + o e e e e e R MRU 486
DI 20|+ e e e R o 17em
DE 20Gm| © ¢ e e e e e W 1B
DI 2o
@ Do MI 19 0|
ML 200w
Ml 2165
o 2268
Designar Fename _[Simulator panel, 2M, 2G, 1 BIB I Gtwmer T Pagedesription [ Dommentng |- P
= BEEND . | - - e e e e e e 1 overview s
| | VUV SN . 9e
“9K2.5 ey -9K2.6 [er
GAMEL m'E]
C - 106
[GRPER
C -30m|
NO - 40w
C - 5om)
N -6
C - 7o)
NO - 80w
£ 90|
o 10e)
Q 110w
AD 120m)
o 130
P 140
@M 150m)
AD 169
@ 7o)
AL 180
o 190
AL 2009
@M 2108
Cetmer

4040000003E
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6. On the last page a display is placed in this project.

-0K2.7 [
e

CEFne NiGw)
- CEFna Niow|

-ap2
iy

s T Frame qround -
o+

s

ms O

omcs 8

NG

o

s O

5 2. DEF-net

(s - DEF et

- CEFna N3G

- CEFna Ndow)
CEIFna NSowo)

Cswmer | Page desription
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Placing diagram macros

Important note:

Before placing DEIF controller diagram macros there is some setup to be made to ensure it works
smoothly.

Go to Functions->Setup

Funktioner | Hjlpeprogrammer Vindue Hjeelp

Egenskaber (overlappende)

- Interval. S
“|  Koordinatindtastning... P
Relativ koordinatindtastning... SKIFT+R
Relativt nulpunkt (0]

L as til grid
Y Las til objekt
Las til punkt Q
L} Konstruktionsmetode
IOyerhold gruppering
Rediger baggrund
. Smart connect

I Direkte redigering
Ind‘[astningsgoks
7 Eksterne programmer...
Laghandtering...
Konfigurer egenskaber...

| / Indstillinger...

Go to —Projects->’your project’->Components->Numbering (online)

£ 77 Projekter Aktuelt kendingsbogstavssaet:

=77 2M1BTB2G test ML300 IEC v
75 Administration
#-77 Forbindelser
@77 Grafisk redigering
=77 Komponenter

@

Kendingsbogstav-underklasser:

IEC 81346-2 v

]

[ Generelt
[ KMB Ved indseetning af symbaler
g EMbB-Isyntakskamrol O Tomt felt
abel
[T Kabler (automatisk) (®) Nummerer

[ Kabler (kabelforbindelser)
[ Klemmer (klemmedele)
[ Nummerer med PLC-data
[T Nummerering (offline)

(O Nummerer med meerket “2*

Nummereringsformat:

{0 Nummerering (online) Side + Kendingsbogstav + Teeller v
[ PLC
T Krydsreferencer / Kontaktspejl
77 Overstielse Ved indszetning af makroer og kopier
77 Rapporter B
5 Visning () Rediger ikke
_ Bruger (& Nummerer
Station
&% Firma (C) Nummerer med maerket *?"

(®) Med forespargsel

Nummereringsformat:

Side + Kendingsbogstav + Teeller v E‘

Mummarar faratribna fartann
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Skema: Side + Kendingsbogstav + Tzeller A4 H | @ % | B

Beskrivelse: Nummerering med side + kendingsbogstav + taller

KMB ]Emegnelser]

Generelle komponenter [S<..,0>]I<..>][C<..,10,abcdefghijkimnoy| ...
[¥] Klemmeraekker [S<...0=]lI<..>][C<..,10,abcdefghijkimnoy| ...
[v] stik [S<...0>]lI<...>][C<..,1,0,abcdefghijkimnoy .,
[¥] Komponentbekse [5<...0>]lI<...>][C<..,1,0,abcdefghijkimnoy .,
Mlpic [S<...0>]ll<...>][C<..,1,0,abcdefghijimnoy .,
[¥] Kabler [S <., 0=][1<..>][C<..,1,0,abcdefghijKimnoy| ...
[v] Samleskinner [1<..>][C<..,1,0,abcdefghijkimnoparstuvw,
V] Generelle Fluid-komponenter <..>][C<...1,0,abcdefghijkimnoparstuvwxyz=]

| Fluid-ledningsfordeler / -forbindelse <..»][C<..,1,0,abcdefghijkimnopqrstuvwxyz>]
[v] Mekanik-kompanenter <..>][C..,1,0,abcdefghijkimnopgrstuvwixyz>]

[ Nummerer indlejrede komponentsymboler

Aonulcy

When adding symbols or macros, the numbering of PLC on the KMB tab should be ON

Skema: Side + Kendingsbogstav + Teeller b4 H | (-

Beskrivelse: Nummerering med side + kendingsbogstav + taller

ks {Betegneiser |

Klemmer [C<..>]
Stikben [C<..>]
[] Komponenttilslutninger [C<..>]
[] PLC-tilslutninger [C<..5]
Samleskinnetilslutninger [C<..>]

[ PLC-adresser
Klemme-sorteringskoder
Rediger ikke PE-, N- og SH-klemmer

Rediger ikke PE-, N- og SH-stikkontakter

&3

Sty

On the designations tab, the PLC-connections and PLC address should be OFF.

As the controller is now defined, the diagram macros are now ready to be placed in the diagram. All cards
now exists with their applicable function definitions and related links to diagram macros. To get to them the

PLC navigator is opened.
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-power in control

jekt Side Placeringsrum Rediger Vis Indseet |Projektdata|Sgg Funktioner Hjeelpe
=P AR AEL L 1 For-planlagning 4
116TB2G test ML300 - x Reference-Administration...
Komponenter 4
ard vl | [ Aktiv Klemmeraekker ’
Stik 4
ﬂavigator PLC
Tilbageskriv tilslutningsbetegnelser... Kabler 4
Angiv datatyper Forbindelser 4

In the PLC navigator the cards as well as all terminals on the cards are now existing. The cross-references
here are to the overview pages where they exists now.

Filter:

Adresseorienteret

Veerdi:

2 9K2
B (PLC box) =P1+A1/9.d.0
F (Part placement, PLC card) =P1+A1/2.2
=-0 9K2.1
B (PLC box) =P1+A1/9.d.0
-8 1 (PLC conn. point, PLC CPS (+)) =P1+A1/9.d.1
-] 2 (PLC conn. point, PLC CPS (-)) =P1+A1/9.d.1
f) 3 (PLC conn. point, PLC CPS (undefined)) =P1+A1/9.d.1
B8] 4 (PLC connection point, DO) =P1+A1/9.d.1
-] 5 (PLC conn. point, PLC CPS (undefined)) =P1+A1/9.d.1
8] 6 (PLC connection point, DO) =P1+A1/9.d.1
B8] 7 (PLC conn, point, PLC CPS (undefined)) =P1+A1/9.d.1
f%) 8 (PLC connection point, DO) =P1+A1/9.d.1
B8] F/G (PLC conn. point, PLC CPS (PE)) =P1+A1/9.d.1
B8] N1 (PLC conn. point for bus cable, general) =P1+A1/9.d.1
[&] N2 (PLC conn. point for bus cable, general) =P1+A1/9.d.1
-[5& (Part placement, PLC card) =P1+A1/2.2
=-00 9K2.2
BE] (PLC box) =P1+A1/9.d5
-H&| 1 (PLC connection point, Al) =P1+A1/9.d.6
B8] 2 (PLC connection point, Al) =P1+A1/9.d.6
F&) 3 (PLC connection point, Al) =P1+A1/9.d.6
-F&| 4 (PLC connection point, Al) =P1+A1/9.d.6

The rack (-9K2) does not have any terminals.
The first card (-9K2.1), a PCM3.1 does have a power supply on terminal 1 and 2 and the status relay on
terminal 3 and 4.

4040000003E
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-power in control

1. When placing the diagram macro, click and hold the left mousebutton over the terminal in the PLC-navigator and drag
into the diagram. After releasing the mopuse button the macro can now be placed freely in the diagram.

L L FO Y 1

Filter:
24VDC wa - -
savben ine Adressec v | | .. []Aktiv
Veerdi:
L - 9K2
R V& (PLC box) =
R I [:=" (Part placeme
. -6 9K2.1
BE] (PLC box) =
. = ———%% (PLC conn.
= | E B I %] 2 (PLC conn.
e E“ 1] 3 (PLC conn.
. - O %] 4 (PLC conne
g2 Cgeel i %] 5 (PLC conn.
] 6 (PLC conne
< 3
T [ose]
Komponenter - 2M1EBTB2G test ML300
The macro is here placed in the right path
TP | I
. coe e P |
BRI ]
. 2051 FY - - - Forbindels

S B DR sl

(Conducto
=P1+A1-9
(Conducto

Co oK P EL T
. . . . . r .=;- . . .
==

- Cowo.

EE e

?L—

... Contjpoller . . o
.. .supply - o .

Note the designation, the cross-refrences are now ready. Below the terminals 1 and 2 a function text is placed.

4040000003E
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On the overview page the cross-references is now already in place, and the function text in the same path as the

terminals are linked to them.

- Fameground RGO
- B Lo ¢

Ref: SEH / Rev. B

2. The next macro to place is the status relay function on terminal 3 and 4. Drag the terminal 3 or 4 into the diagram
K
B
Ay
By using the tab, another variant of the macro can be called. This one with terminal 4 above and terminal 3 below.
1 4: S
-
3 s
This method is applicable for a number of diagram macros, namely relays and othe inputs and outputs.
3. When placing the measurement inputs on the ACM card, each measurement value is placed seperately. The first
terminal holds the PLC-box though.
First terminal is placed with the box
T Verage |
- measurement
Generator
Do wolkage
[Simulator nanel. 2M.7G. 1 RTR
4040000003E
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Second terminal is placed

ey e s o
Coo | Voltage. | .
------ - meagurement -

L Generatorl D00
voltdge - - - - - -

All terminals are now placed

L] B

L -0K2.2 ¥2 %3 ¥4
S I B -
E R
M= R0V ACINace- Ahage walue
. Moltage.
- measurement -
S Generator. |l

. . volage . - - - . -

And the crossreferences and function text on the overview page is in place

ok2.2 ey
Fney

B L. B o]
- N2 - 60w

coN-D - 1Emb |33 -
©oN-l2 - Zemp|133 -
SN - 3ol (3.3 -

VAN - 4|13, -

Generaoe vokege

4040000003E
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Ref: SEH / Rev. B

Placing graphical macros

| an exact graphical overview of the controller is needed it is possible to build by using the graphical
macros. They are built on a graphical page with the grid set to 1 mm and the scale 1:1.

1. Create a graphical page with grid 1 mm and scale 1:1.
2. Insert a macro
5 | Indsaet | Projektdata Sgg Funktioner Hjelpepr
[
& © Symbol.. INS
,|:]{: Vindues- / symbolmakro... M
Komponent... ALT+INS
3. Find the Rack macro, ensure it is set to Graphics and Open
,i\ x
Lookin: | | ML-300 v @ % Er ] Preview
L Name - Date modified 2
~ DEIF_ML-300_PCM31_ETH_N2.ems 10-06-2015 09:11
Recent places DEIF_ML-300_PCM31_ETH_N3.ems 10-06-2015 09:11
DEIF_ML-300_PCM31_ETH_N4.ems 10-06-2015 02:11 2 &
- DEIF_ML-300_PCM31_ETH_N5.ems 10-06-2015 09:11
Desktop DEIF_ML-300_PSM31.ema 25-06-2015 16:57
== DEIF_ML-300_PSM31_ETHCAT_N1.ems 10-06-2015 09:26
- 1| DEIF_ML-300_PSM31_ETHCAT_NZ.ems 10-06-2015 09:26
Libraries DEIF_ML-300_PSM31_PS_1_2.ems 10-06-2015 09:26
o DEIF_ML-300_PSM31_RO_3_4.ems 10-06-2015 09:26
k DEIF_ML-300_PSM31_RO_5_6.ems 10-06-2015 09:26
This PC DEIF_ML-300_PSM31_RO_7_8.ems 10-06-2015 09:26 ¥ v
@ {v| | DEIF_ML-300 RACK7 1.ema 25-06-2015 16:48
] \Y
: < Type: EMA File >
Network Size: 1,06 MB
File name: DEIF_ML-300_| Date modified: 25-06-2015 16:48 Open 24.8441
] - Std makroer ML-300
Files oftype Vinduesmakro, symbolmakro (*.ema,”.ems) v Cancel
Visningstype: ‘Grafik <5 v]
Variant: Variant A
Sti: Q\Eplan\Eplandata\Data\Makroer\150..\ML-300
4040000003E
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-power in control
4. Place the macro by pressing X and Y fixing it in a certain position on the page
(M @)
145 1| & T B o Z
¢ i i = - 5 - e—
V \
T Tt T
‘:;:: ‘» =
5. Insert the next macro, the PSM3.1 card in the same way. By pressing X and Y this is placed in the first slot.
[ s |
&) n
= o e
)
<
. 17
J \
mulator panel, 2M, 2G, 1 BTB ‘“z Costomer I;

4040000003E
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6. Continue to fill the rack with cards and blind plates as configured. Some cards need to be fixed on the Y-axis only as
they need to be moved sideways in the slots.

{1
L (T (e =61
ACM3.1 10M3.1 EIM3.1 SR PEERA
=l _=n :':53” -1
i (I iz
AeF kel
2 &
et =B [ :
HENE L
i + s
a0 []|-] *i s
| -l fﬂg ek oh 5%
DR | Djl}ﬂg fiH' M e
L 4 rLe o
g Eg e Py o
pur = = = -
o el (I Zhsl (|8 7
4] & s
8 o £l = > Ju %Eij
et B =t a -
E -a| i v Eg :i e Ll
E = <ol I= Qv
- (70
L ~
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Inserting panel layout 2D macros

When inserting panel layout macros, it needs to be done on a page type ‘Panel Layout’ with a defined
‘mounting plate’ box representing the mounting plate.

In this example | have a page set to scale 1:5, typical for a big panel. | also defined a mounting plate box.

Note* Variant B of the panel layout macros for rack and display unit holds the cut-out/drilling template.

1. Open the 2D panel layout navigator by Project data -> Components/articles -> 2D-panel layout-navigator

Placeringsrum Rediger Vis Indszet | Projektdata | Sgg Funktioner Hjeelpe

¥ Gy i | D £ For-planlaegning -
L300 -x [~ | Reference-Administration..
| | Komponenter |
vl | o L Aktiv Klemmeraekker b
Stik »
PLC »
‘ Kabler »
| Forbindelser 4
11 Ee Stykliste-navigator Koemponenter / Artiklg
D—tavlelayout—?avigator_ MeFinger N 4

E= Komponentliste E- Symboler

2D-tavlelayout L4
L |
2. Here the ML-300 controller from before can be found
2D-tavlelayout - x
Filter:
Elektroteknik v | .| L] Aktiv
Veerdi:
9K1.6 ~
9K1.7

L 2 e 2 e

-

=

aK2.4
aK2.5
aK2.6
aKa2.7
T
SK3.1

aK2
aK2.1
aK2.2
aK2.3
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3. Find the rack (here it is -9K2), click and hold the left mouse button on it and drag it onto the mounting plate.

Adresseonentere v . || Aktiv

Veerdi:

-MOUNTINGPLATE|

-0 ML-100

7l Uden strukturkendetegn
BTB2G test ML300

1

2D-tavlelayout - 2M18TB2G test ML300 .=

Filter:
Elektroteknik v| | .| [Aktiv

Veerdi:

I |
\\ K16 ~

T~ oK1.7
K2
9K2.1
9K2.2
9K2.3
9K24
9K2.5
9K26
9K2.7
v 9K3
> 9K3.1 v

Simulator panel, 2M, 2G, 1 BTB I Cusmmer | Page description
- pEFE anel overviev

4, Mark all the cards in the rack.

2D-tavlelayout - 2ZM1BTB2G test ML300 . x
Filter:
Elektroteknik v | L[] Aktiv
Vaerdi:
10 9K 1.6 ~

E
=07 9K1.7

- v 9K2
-0 K21
-0 9K2.2
-0 9K2.3
-0 K24
-0 9K2.5
=07 9K2.6
-0 QK27
-7 9K3
-0 9K3.1 v

e [uste]

4040000003E
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5.

Ref: SEH / Rev. B

Drag them into the rack. The first card will now be ready to place. Place it in the first slot and press ‘Enter’. The next

card i then ready press ‘Enter’ until all 7 cards has been placed.

PLATE

-9K1

Multi-line 300

b

-9K1.

-9K1.6

-9K1.7

(i3}

-9K1

Hulii-ine 300

= 0

HELY BT BT By

@ |-9x1.3

S S|

T

TN

5) [Esaan) Jsssesss

137 MR CE{EiLn

@

@
m
0

r\-gqﬁ
o §
=1~

B
H

o-ii

[ 1
20 E‘=’” 0000 [Ho0 0os

=

a

Lk ]

=

i

Vaerdiz

(3 S S i
~IomE

[ 9K1
9K1.1
//:g 912
X 9K1.3
w71 9K1.4
T K15
[ 9K1.6
w1 9K1.7
T 92
I 9K2.1
w7l 9K2.2
T 923
[ 9K2.4
w7 9K2.5
T K26
A oK 9K2.7
-] 12K1
o B 1361
-] 14K1
-] 15K1
o D 16K1
=[] 19K1
-7 25K1
o [0 25K2
=[] 25K3
- [67] 25K4
& [ 25K5
=[] 32K1
- [67) 32K2

E\ -

O < O o O < = O O
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6. Displays can be placed in a similar fashion.

=7 Alle artikler

3051 3452 3451 w-d H

3 33P3  32P1 [l 2[X7] 9P1
Il [ 9P2

22p1
2351 3151 3is2 22P2
21P1
T e T Y ] 32P1

Before placing the macro it is possible to toggle the front folio to the right type by pressing TAB.
Eplan is not showing the different folios, but the sequence is as follows:

PPM-display:
DG -> EDG -> Shaft/shore -> Bus Tie ->

PPU-display:
DG_GB control -> GB control -> GB indication -> Blank ->

Door cut-out

The thin brown line represents the door cut-out. After placing the display it is possible to ungroup
the macro and delete the remaining parts for the cut-out to be dimensioned or exported to the
workshop.

4040000003E

Printed date: 170428  Page 26 of 27



DEIF ML-300 Eplan macro user guide

Ref: SEH / Rev. B

-power in control

Rediger Vis Indsat Projektdata Sgg Funktioner Hisslpeprogrammer Vindue Hjslp

[ Afbryd handling ESC
P Fortryd via liste
7 Fortryd CTRL+Z
3 Annuller fortryd CTRL+Y
qAnngller fortryd via liste
M Kiip CTRL+X
Kopier CTRL+C
I Seet ind CTRL+V
[#] Dupliker D
st v
2 Roter CTRL+R
Al Spejlvend
ioa Slet DELETE
Slet placering ALT+DELETE
Marker
Grafik
@ Kopier format

Opret vindues- / symbolmakro...  CTRL+F5
Mere
Tekst

D | tabelform

Funktionsuafhangige egenskaber...
Egenskaber...

CTRL+C

CTRL+D

N
N

w
overview
2 overview
! overview
! overview
=rview
=rview
Tview

rview

Juster (horisontalt)
Juster (vertikalt)

fFab =8 Bl €
»
r..(!)
b oD
oy
oM
HHf Grid A <)
» | $E Grid B -
HrGridC —
Hb Grid D 6
HEGrid E 5
I Placer pa grid 6

Fordel jazvnt (horisontalt)
Fordel jazvnt (vertikalt)

Grupper

=

Grupper kemponent

:": Opheev gruppering

Forrest

Bagest

Dan blok

Ophzv blok

Konverter koemponentsymbol til grafik
Abn hyperlink

Genveje...

Keonfigurer beskyttelse...

The cut-out is placed in layer EPLANG72

[ ] -2354

[ ]-23H4

-3051

O

-32P2

O

-3251
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